Excel Data Bridge
Project Accounting Function » >

Introduction

The Project Accounting function enables you to create new projects and make changes to

existing projects in Sage 200.

It emulates both the Create Project and Amend Project features available in Sage 200 via
Project Accounting > Projects.

Project Accounting

Projects List

Project Accounting Process Map

Create Project

Amend Project

Delete Project

Amend Project Status
Amend Project Status - Bat...

Create Project from Sales ...

Create Project from Quotati...

The multiline template allows multiple projects to be created in Sage 200 at once; and multiple

existing projects can be easily downloaded, amended and reuploaded to Sage 200

Field Mappings

A 8 G H 1 J K L M N o
Excel Project Accounting
L 2 Data Bridge
1
2| Header Details
El status [ create/am[d createneleld Movetiverld GroupsyiD B itemiD B parentip B Projectcode B itemType Bl code B2 ritle B2 projectstatus B completesld status Narrid Description
4| A n "108545 ’0000000010  Project Consultation  Initial Consultation for Somerhill Homes Complete
5 | A 1 "0sssa 08545 item Kitchen 0] Initial taken during ion project.
6| A n "0ss59 108545 item Design Ktchen Design Kitchen Design - Part of the initial consultation project.
7] A b "127068 i Project C i Better Kitchens Consultancy 8id
8| A 2 27077 127068 Group Consult Consultation with Customer regarding new kitchen. Open ) Consultation with Customer regarding new kitchen. Including proposal and
9| A ¢ 27088 127077 item Site Visit On Site Visit to discuss options <Not Applicable> "0 On Site visit to discuss design and implementation options
10| A P2 27094 127077 item Proposal Submittion of Proposal <Not Applicable> 0 Proposal being submitted and drafted to customer for approval.
1] A 2 727100 127077 Group Design Cad Design and Print Open 0] Cad design work to be created including drawings and 3d imagery if
12| A 4 27717 ¢ Project C Cherrie - 27 Chelford In Progress
13 A B T21727 21717 Group Consult Consultation with Customer regarding new kitchen. In Progress 0] Consultation with Customer regarding new kitchen. Including proposal and
14 A fa M27736 127727 item Site Visit On Site Visit to discuss options In Progress o On Site visit to discuss design and implementation options
15| A 3 M27782 27727 item Proposal Submittion of Proposal In Progress 0 Proposal being submitted and drafted to customer for approval.
16 A 3 M27708 127727 Group Design Cad Design and Print In Progress ) Cad design work to be created including drawings and 3d imagery if

The field mappings are controlled within the Designer button in the Excel Data Bridge tab.
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&3 Map Fields

BillingAmendEvent|D

_T
AdditionalValues | Additional Values

BillingAmendEvent1D

BillingCompleted

BillingCompleted

BillingDescription

BillingDescription

BillingEventFlag

BillingEventHag

BillingEventlD

BillingEventID

BillingEventType

BillingEvent Type

BillingEventValue

BillingEventValue

BillingTemplate

BillingTemplate

DownloadEvents

True

OverwriteTemplateClai

BBPCostQuantity

False

BBPCostQuantity

BBPCostValue

BBPCostValue

BBPRevenueQuantity

BBPRevenueQuantity

BBPRevenueValue

BBPRevenueValue

DownloadBudgetsByPe

True

Period

Period

UseBudgetsByPeriod

ContactAddress1

UseBudgetsByPeriod

ContactAddress2

ContactAddress3 ContactAddress3
ContactAddress4 ContactAddress4
ContactAmendID ContactAmendID
ContactDescription ContactDescription
ContactEmail Contact Email
ContactFax ContactFax
ContactFlag ContactHag
ContactName ContactName
ContactPostal ContactPostal
ContactPostcode ContactPostcode
ContactTelephone Contact Telephone

Download

SetAsDelivery

CostQuantity

CostUnit

CostValue

OtherCostsRules

OverrideCostBudgets | OverrideCost Budgets
OverrideRevenueBudg| Override Revenue Budgel
ProjectOwner ProjectOwner
RevenueQuantity RevenueQuantity
RevenueValue RevenueValue
StocklssuesRules StocklssuesRules
TimesheetRules TimesheetRules

UnitCost UnitCost

UpliftValue UpliftValue

Additional Info

S x 3L

The Additional Info section shows the Sage 200 fields
available to the Additional Information area in the Details

tab of the project in the left-hand column.

The Billing Events section shows all Sage 200 fields
available to the Billing Schedule area of the Customer

Billing Details screen in the left-hand column.

Costs & Charges > Select Customer > Edit

The Budget by Period section shows all Sage 200 fields
available to the Budgets by Period area in the Costs &

Charges tab of the project in the left-hand column.

The Contact Information section shows all Sage 200
fields available to the Contact Info tab of the project in the

left-nand column.

The Cost & Charges section shows all Sage 200 fields
available to the Costs & Charges tab of the project in the

left-nand column.

If an entry appears in the right-hand column, it means the Sage 200 field is mapped to a cell, or

range of cells in the Excel worksheet.
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BillingCustomer

BillingCustomer

BillingFlag BillingHag
BillingPriceQuoted BillingPriceQuoted
BillingQuantity BillingQuantity
BillingSzlesOrderNo | BillingSalesOrderNo
BillingUnitPrice BillingUnitPrice
BillingUoM BillingUoM

DownloadCustomer

Description

True

PercentageComplete | PercentageComplete
ProjectStatus Project Status
StatusNarrative StatusNarrative

Title

BillingAmendClauselD

BillingAmendClauselD

BillingClauseAccount

BillingClause Account

BillingClauseCalcMeth!

BillingClauseCalcMethod

BillingClauseCC BillingClauseCC
BillingClauseDept BillingClauseDept
BillingClauseFlag BillingClauseHag
BillingClauselD BillingClauselD

BillingClauseNarrative

BillingClauseNarrative

BillingClauseNegatives

BillingClauseNegatives

BillingClauseRevenue

BillingClauseRevenue

BillingClauseType

BillingClause Type

BillingClauseValue BillingClauseValue
BillingClauseVAT BillingClause VAT
DownloadClauses True
BrowseResults BrowseResults
CascadeWIP False
Code Code
CreateAmendIndicator | Create Amendindicator
CreateDeleteFlag CreateDeleteHag
GroupByld GroupByld
ItemlD ftemID
ltemType ftemType
MoveLiveProject MoveliveProject
ParentlD ParentID
ProjectCode ProjectCode
Status ®

Expensefccount ExpenseAccount
ExpenseDept ExpenseDept
ExpensseCC ExpensseCC
Revenuelccount RevenueAccount
RevenueCC RevenueCC
RevenueDept RevenueDept
WIPAccount

Status

Choose a cell or range of cells to display the upload

status

S x 3L

The Customer Billing section shows all Sage 200 fields
available to the Quotation Information area of the

Customer Billing Details screen in the left-hand column.

Costs & Charges > Select Customer > Edit

The Details section shows all Sage 200 fields available to
the Current Status area in the Details tab of the project in

the left-hand column.

The Event Clauses section shows all Sage 200 fields
available to the Billing Lines area of the Customer Billing

Details screen in the left-hand column.

Costs & Charges > Select Customer > Edit > Details

The General section allows custom cell mappings to be

created to hold data from browses. Not covered in this

document

The Header and Information sections shows Sage 200
fields available to the header section of the project record,

and some Excel Data Bridge specific fields.

The Nominal Defaults section shows all Sage 200 fields
available to the Nominal Defaults tab of the project in the

left-nand column.

An explanation of the property selected is shown at the bottom of the Designer window.
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NOTE - These default mappings can be amended to suit your business requirement and will be

explained later in the document.

Multiline Template

There are seven worksheets within this template. All Fields contains every field available to

populate when creating Sage 200 project records via Excel Data Bridge.

AllFields Details Cost8iCharges | BudgetsByPeriod ‘ CustomerEBillingDetails ‘ Contactinfa ‘ Mominal | Help & Support

The remaining seven worksheets have been created with the individual area in the Sage 200

project record in mind.

Before making any changes to existing Sage 200 projects, or creating new projects, it will be

useful to know how the template relates to the different sections of the Sage 200 project records.

By understanding this, this should help you decide which worksheet in the template will best fit

your needs, and which columns you need to complete.

Any unrequired columns can be unmapped and removed from the worksheet. This is covered in

a later section in the document.

All Fields Worksheet

Columns A - G of the multiline template are specific to Excel Data Bridge. These fields will

always be required on the template.

The table below explains the purpose of each of these fields: -
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Status
Populated when selecting the Create / Amend Project button on the

Excel Data Bridge ribbon.
The default status on a successful creation will be

When attempting to post to Sage 200, the status field should either be
cleared, or display a status of . Any other data entered in this
field will prevent the project being created / amended in Sage 200.

Should an error be returned in this cell when attempting to post, it will

appear in red. The error should be corrected in the worksheet, and the
status field cleared before attempting to post again.

Create/Amend Let Excel Data Bridge know if the data being entered is for a new or

existing project, enter: -

» C to create a new project record
+ A to amend an existing project record

CreateDeleteFlag Let Excel Data Bridge know if the data being entered should add or

delete a project line from a project structure, enter: -

(Amend Only)

+ C to add a new project line to an existing project structure
» D to delete a project line from an existing project structure

MovelLiveProject Supports the Move Live Project feature in Sage 200 project structure.

Set to TRUE to move an existing live project(s) to form part of a new

project structure.

See page 25 for more information

GroupBylD IMPORTANT - See section for Group By ID on page 27

ItemID
Enter a unique ID against each project, group and item relating to any

new project records being created. This can be alpha or numeric.

This column will populate automatically if existing project records are
downloaded into Excel Data Bridge.
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ParentiD

Enter the Item ID of the parent item in the project to create a project

structure for any new project records being created.

This column will populate automatically if existing project records are
downloaded into Excel Data Bridge.

After this, on row 2 of the worksheet, headings appear indicating which area of Sage 200 the

columns within the section belong to.

Header Section

The header section columns represent the fields available to the project header in Sage 200.

A | B | G | D ‘ E | F | o H ‘ | ‘ ; p | )
m Excel Project Accounting
+ > 2

Data Bridge

Header Details

B L1 AL AT R U EGLE DRSS T M VIUVELIVErTU J-UL I GTUUPDYIU B 1L R AT U B FIUJEULDUS g LT ypE R LUUE g Tiue B FiujELLawS
v v P 5
4 | 1 1764212 0000000023 Project Consultation test In Progress

These fields will always be required on the template.

Amend Project = O X

Project Structure Project

EL"J 0000000020, Cherrie - 27 Chelfory Code: 0000000020 Title:  Cherrie - 27 Chelford
=[] Consult, Consultation with Cus
ia2 Site Visit, On Site Visit to ¢

g’g Proposal, Submittion of Pri Netaile

. ) 2i-CIEN Costs & Charges | Contact Info | Attachments | Memo
~~~~~~ Design, Cad Design and P [ 1

Selected Project Level: Consultation

The table below explains the purpose of each of these fields: -

ProjectCode
Enter a project code for any new project records being created or

leave blank to use the next available project code (if Sage 200 is set to
automatically generate project codes).
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ItemType

Select the item type for each project level item required for the project
from the drop-down options of Project, Group or ltem.

Enter a code for each project level item required for the project or
browse existing project item codes in Sage 200 for each item type by
right clicking on the cell and selecting Excel Data Bridge Browse.

Enter a title for each project level item.

Details Section

The details section columns represent the fields available to the Details tab for each project level
in the Sage 200 project.

If any of these fields are not required to create / amend Sage 200 data, they can be unmapped

and removed from the template — see page 37 for instructions.

Project Structure Project

El[:] 0000000020, Cherrie - 27 Chelfory Code: 0000000020 Title: Cherrie - 27 Chelford

E!--» Consult, Consultation with Cus
; ite Visit, On Site Visit to
roposal, Submittion of Pri|
esign, Cad Design and P

Selected Project Level: Consultation

15T Costs & Charges | Contact Info | Attachments | Memo

Current Status

Status: In Progress \ Change Status...

Description

Additional Information

Commercial Project? Yes

Days Taken 14.00000
Designer KIT002
Region North East

The table below explains the purpose of each of these fields: -

ProjectStatus . : , ,
Enter a status for each project level item, or right click on the cell and select

Excel Data Bridge Browse, if the item type allows status setting.

Complete% e :
Enter a number indicating the percentage complete for each project level

item, if the item type allows setting of percentage completion.

Status Narrative

Enter a status narrative for each project level item where a project status has
been applied.
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Description

Enter a description for each project level item, if the item type allows
description entering.

Additional Info

The remaining columns in the Details section represent any additional
Columns

information fields that have been created in Sage 200 via Project

Maintenance > Additional Information.

The template has been designed to include 16 extra fields as standard,

should more be required, please contact support to amend the template.

Enter the value of any additional information fields already existing in Sage

200 required for the project item type, or right click on the cell and select
Excel Data Bridge Browse.

Costs & Charges Section

The costs and charges section columns represent the fields available to both the Budgets and

Costs sections of the Costs & Charges tab for each project level in the Sage 200 project.

If any of these fields are not required to create / amend Sage 200 data, they can be unmapped

and removed from the template — see page 37 for instructions.

Project Structure Project

Ell:_] 0000000020, Cherrie - 27 Chelfor: Code: 0000000020 Title:  Cherrie - 27 Chelford
EJ Consult, Consultation with Cus
ez Site Visit, On Site Visit to ¢

a2 Proposal, Submittion of Pri Details [¢
Budgets

Cost qty: 1 2.00000  Revenue aty: [ 0.00000
Cost value: £ ‘ 20.00] Revenue value: £ [ 0.00

Selected Project Item: Miscellaneous Items - Site Visit - On Site Visit To Discuss Options

| Nominal Defaults | Attachments | Memo

------ Design, Cad Design and P

Use budgets by period: O ‘ Budgets by Period... | ’ View History... ’
Costs Time & Materials Pricing Rules

Unit cost: £ [ 10.00000] Timesheets: ' Charge Rate v |
Cost unit: | <NotApplicable> v |  Stockissues: [Standard Price v
Upiift %: 1 0.00  Other costs: |Cost v

The table below explains the purpose of each of these fields: -

CostQuantit
g Enter the cost quantity for the project item, if the item type allows setting

of cost budgets.

CostValue

Enter the cost value for the project item, if the item type allows setting of
cost budgets.
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OverrideCost
Set to TRUE to for Project and Group item types to specify cost

quantity and value at project / group level, if item type allows cost budget
setting, else set to FALSE, or leave blank.

RevenueQuantity

Enter the revenue quantity for the project item, if the item type allows
setting of revenue budgets.

RevenueValue — : .
Enter the revenue value for the project item, if the item type allows

setting of revenue budgets.

OverrideRevenue
Set to TRUE to for Project and Group item types to specify cost

quantity and value at project / group level, if item type allows revenue
budget setting, else set to FALSE, or leave blank.
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ProjectOwner

Enter the username of the project owner (at project level), or right click
on the cell and select Excel Data Bridge Browse.

UnitCost ) S ) ) .
Enter the unit cost for the project item, if the item type allows setting of

cost units.

CostUnit

Enter the cost unit for the project item, if the item type allows setting of
cost units, or right click on the cell and select Excel Data Bridge
Browse.

UpliftValue . s .
Enter the uplift value for the project item, depending on overhead

absorption settings, which could be a value or a %.

TimesheetRules - . L .
Enter the pricing rule to use for timesheets for the project item, or right

click on the cell and select Excel Data Bridge Browse.

StocklssuesRule . . o .
Enter the pricing rule to use for materials for the project item, or right

click on the cell and select Excel Data Bridge Browse.

OtherCostRule . — .
Enter the pricing rule to use for other costs for the project item, or right

click on the cell and select Excel Data Bridge Browse.

Budgets by Period Section

The budgets by period section columns represent the fields available to the Budgets by Period

area of the Costs & Charges tab for each project level in the Sage 200 project.

If any of these fields are not required to create / amend Sage 200 data, they can be unmapped

and removed from the template — see page 37 for instructions.
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Project Structure
&[] 0000000020, Cherrie - 27 Chelfory
z] Consult, Consultation with Cug
Visit, On Site Visit to ¢
= Proposal, Submittion of Pri|
Design, Cad Design and P
Budgets By Period = a X
Cost qty: 3.00000
Cost value: £ 120.00 @ ®
Override sub item cost budgets: | Period Breakdown
\Iss budgets by perod: O [Perios 4] Total Cost Qty | Total Cost Value
Project Owner 311212021 0.00 0.00
Sage 200 user name: [ ! ‘ 31/01/2022 0.00 0.00
8/02/2022 0.00 0.00
Customer Information 31/03/2022 0.00 0.00
s om oo [l
BETO001 Better Kitchens 3110512022 0.00 0.00
30/06/2022 0.00 0.00
31/07/2022 0.00 0.00
31/08/2022 0.00 0.00
30/09/2022 0.00 0.00
31/10/2022 0.00 0.00
30/11/2022 0.00 0.00
‘ Add... I l Edit. | l Delete ] | Defaults... l 31122022 0.00 0.00
Totals 0.00 000
Lo o

The table below explains the purpose of each of these fields: -

UseBudgetsByPeriod
Set to TRUE to enter cost / revenue budgets by period, if

the item type allows setting of cost/revenue budgets, else
set to FALSE, or leave blank.

Period Enter the budget period date or browse to select.

BudgetPeriodCostQuantit
< y Enter the cost quantity, if the item type allows the setting of

cost budgets.

BudgetPeriodCostValue ) ) )
Enter the cost value, if the item type allows the setting of

cost budgets.

BudgetPeriodRevenueQuantity o )
Enter the revenue quantity, if the item type allows the

setting of revenue budgets.

BudgetPeriodRevenueValue

Enter the revenue value, if the item type allows the setting
of revenue budgets.

Customer Billing Section

The customer billing section columns represent the fields available to the Customer Information

area of the Costs & Charges tab at the Sage 200 project header level.
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If any of these fields are not required to create / amend Sage 200 data, they can be unmapped

and removed from the template — see page 37 for instructions.

Customer Billing Details - m} X
(U O]

Customer Information Quotation Information

Code: GE0001 Quantity: [ 1.00000|  Price quoted: g 90000.00000)|

Short name: George Unit price: £ 90000.00000 Sales order no: 0000000358

Postcode: DE4 6YH Unit of measure: | <Not Applicable> v|  Defautttemplate: v ] l ‘

Billing Schedule
Description | Event Type | Event Value | Billing Template | Comp.
June Costs booked Date 21/06/2007 Kitchen template (12/06/2... Yes
August Costs Booked Date 31/08/2007 Kitchen template (12/06/2... Yes
Remainder of The Project Costs Project Status Complete Kitchen template (12/06/2... No

Billing Schedule Details

Description: lJune Costs booked ! Biling Template: ‘ Kitchen template (12/06/2007 15:27) ‘ Details.
EventType:  |Date v | EventVale: |21/062007 ] Completed
\ 0K ‘ ’ Add ‘ | Delete ‘ l ldove Up | l Move Down ‘ Cancel ‘

The table below explains the purpose of each of these fields: -

CustomerBillingFlag . )
Enter D to delete a customer billing schedule at project level. Any

events / clauses related to the schedule will also be deleted.

CustomerBillingCode ) ) )
Enter the customer account reference to bill at project level, or right

click on the cell and select Excel Data Bridge Browse.

BillingQuantity Enter the quantity for the quotation at project level.

BillingUnitPrice Enter the unit price for the quotation at project level.

BillingUoM

Enter the unit of measurement for the quotation at project level, or right
click on the cell and select Excel Data Bridge Browse.

BillingPriceQuoted Enter the price quoted for the quotation at project level.

BillingSalesOrderNo Enter the sales order number for the quotation at project level.
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BillingEventFla
< < Enter D to delete a customer billing event at project level. Any

clauses related to the schedule will also be deleted.

BillingEventID Enter a unique ID for each bill being added to the customer schedule.

e e | S Displays a record ID of an existing event when project downloaded.

Required when making amendments to / deleting billing events.

BillingDescription Enter a description for each bill added to the customer schedule.

BillingEventType . . . .
Enter the billing event type for the project, or right click on the cell and

select Excel Data Bridge Browse.

BillingEventValue Enter the value for the billing event.

BillingTemplate . . , ,
Enter the billing template to use for the project, or right click on the cell

and select Excel Data Bridge Browse.

BillingCompleted
~ e - Set to TRUE to mark the billing as completed at project level, else set

to FALSE, or leave blank.

The following fields are available to the Details screen of the Billing Schedule Details area of
Sage 200:

Billing Schedule Details
Description: | June Costs booked |  Biling Template:  |Kitchen template (12/06/2007 15:27) | Detais
EventType: | Date v | EventValue: | 21/06/2007 334 ‘ Completed

BillingClauseFlag Enter D to delete a customer billing clause at project level.

Al Displays a record ID of an existing clause when project downloaded.

Required when making amendments to / deleting billing clauses.

BillingClauselD Enter a unique ID for each clause in a billing event.

BillingClauseNarrative Enter a narrative for each clause added to a billing event.
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BillingClause Select the billing clause calculation method from the options given in

CalculationMethod the drop-down list.

BillingClauseValue Enter a clause value for the specified calculation method.

ST [H EUEERNT IR YA Select the clause type to show from either Detail or Summary.

BillingClauseRevenue . , .
Enter the billing clause revenue code, or right click on the cell and

select Excel Data Bridge browse.

BillingClauseVAT

Enter the billing clause VAT code, or right click on the cell and select
Excel Data Bridge browse.

BillingClauseAccount , . , .
Enter the nominal code for the billing clause, or right click on the cell

and select Excel Data Bridge browse.

BillingClauseCC ) ] )
The cost code for the nominal account will be updated on nominal

code selection from a browse.

BillingClauseDept ) ) )
The department for the nominal account will be updated on nominal

code selection from a browse.

BillingClauseNegatives ) ) ) S
Enter TRUE to include negative entries for the billing line, or FALSE to

exclude.

Contact Info Section

The contact info section columns represent the fields available to the Contact Info tab at the

Sage 200 project header level.

If any of these fields are not required to create / amend Sage 200 data, they can be unmapped
and removed from the template — see page 37 for instructions.

Project Structure Project

B"'l:l 0000000020, Cherrie - 27 Chelfori Code: 0000000020 Title: Cherrie - 27 Chelford
=& Consutt, Consultation with Cus z 5

: = Site Visit, On Site Visit o ¢ Selected Project Level: Consultation
== Proposal, Submittion of Pri Cei
e Design, Cad Design and P

Details | Costs & Charges =) & Attachments | Memo

i)

Contact Information

Description | Contact [ Delivery 1
Design Contact John Duffy
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The table below explains the purpose of each of these fields: -

ContactFla
< Enter D to delete a customer contact at project level. Ensure the

contact amend ID is populated before posting amendment.

S EE TR Displays a record ID of an existing contact when project downloaded.

Required when making amendments to or deleting existing contacts.

(o111 = ST G WYETRVAR Enter TRUE to assign contact as delivery contact.

ContactDescription Enter the description of the contact.

ContactPostalName Enter the postal name of the contact.

(076171 = (o3 7o o [N A Enter the address lines of the contact.

ContactName Enter the name of the contact.

ContactTelephone Enter the telephone number of the contact.

ContactFax Enter the fax number of the contact.

ContactEmail Enter the email address of the contact.

ContactPostcode Enter the postcode of the contact.

Nominal Defaults Section

The nominal defaults section columns represent the fields available to the Nominal Defaults tab

at each Sage 200 project item level.

Project Structure Project

Ell:l 0000000020, Cherrie - 27 Chelfor Code; 0000000020 Title: Cherrie - 27 Chelford

=5 Consutt, Consultation with Cus
iaZ Site Visit, On Site Visit to ¢
3; Proposal, Submittion of Pry

Selected Project Item: Miscellaneous Iltems - Site Visit - On Site Visit To Discuss Options

Details | Costs & Charges Attachments | Memo

'''''' Design, Cad Design and P

Default Nominal Codes

Expense: | v 44104 | SAL IADM ] Miscellaneous Purchases

Revenue: | v 31101 l SAL | ADM ] Miscellaneous Sales

The table below explains the purpose of each of these fields: -
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ExpenseAcc . o .
Enter the expense account nominal code for the project item, or right

click on the cell and select Excel Data Bridge Browse.

ExpenseCC . .
The cost centre of the expense account will be populated on nominal

code selection from a browse.

ExpenseDept . .
The department of the expense account will be populated on nominal

code selection from a browse.

ExpenseNominal The name of the expense account will be populated on nominal code
Description selection from a browse.

RevenueAcc . C .
Enter the revenue account nominal code for the project item, or right

click on the cell and select Excel Data Bridge Browse.

RevenueCC . .
The cost centre of the revenue account will be populated on nominal

code selection from a browse.

RevenueDept

The department of the revenue account will be populated on nominal
code selection from a browse.

RevenueNominal The name of the revenue account will be populated on nominal code

Description selection from a browse.

Creating New Projects...
You can create new Sage 200 projects using Excel Data Bridge by the following methods: -

* Downloading existing project templates
* Downloading existing project records
* Manually from scratch

Downloading either an existing template or project from Sage 200 is probably the easiest way to

create new project records, but all three methods will be discussed in the document.

When creating new projects, we recommend using the AllFields worksheet in the template as it

provides all project record data fields from Sage 200.
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...from Project Template

Any existing project templates in Sage 200 can be downloaded into Excel Data Bridge and new

projects created from them.

Clicking Download Project Templates displays the content of the Project Templates area in
Sage 200.

@3 Template Download = O X
Submit Cancel

7 Title

Advanced Kitchen Project Template
Consultation Project Template
Kitchen Fitting Only

Normal Kitchen Template

You can download single or multiple project templates. Once a template is downloaded any

existing data in the worksheet will be overwritten.

See example below where Kitchen Fitting Only template has been downloaded.

Points to note: -

* The Group By ID column contains the same data for each project line.

* Theltem ID and columns provide your project structure. Each item ID
downloaded from Sage 200 is unique, and the parent ID downloaded points to which
project level each item belongs to. The top level of the project will not have a parent.

« The column confirms that this project contains one project level item and six

project items, which are pointing to the project level item ID as their parent.

Make any changes required to the data downloaded from the template, including removing any

project items that are not required.

E F G H [ J [ K L | M | N [}
Header Details
Parenti ttemType | § B projectstatus B complete%: Bl status Narrative Bl Description
¥

Kitchen Project for Tynedale bank.

1 itemin]
F

'126820 | Project Project Open 0 Cad design to be organised and other external factors to be considered.
'116830 .126810 Item Kitchen Sale Kitchen Sale L Full project to be billed using this item.

'126835 }26810 Item Fitting Kitchen Fitting '0 Kitchen Fitting - Includes cabinet construction, worktops etc...

'126849 126820 Item Measurements Kitchen Measurements P Initial measurements taken during consultation project.

'126853 '126820 Item Plaster Plastering service for Kitchen P All Skimming and plastering work.

'11687? }26810 Item Removal Kitchen Removal P Removal of kitchen - part of phase 1.

126891 J§| 126820 ltem Tiling Tiling work on Kitchen 0 Floor or Wall tiles to be grouted and fitted.
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To create a new project record, enter C in the Create/Amend column against the project level

item, add a Title for the project level item then click Create / Amend Project.

/‘S 1”\
)

Create/
Amend Project

Create / Amend Project will attempt to create the project in Sage 200. This

process also performs a full Sage validation check.

If successful, the status cell will change to Processed against each project item and the project

code created will be returned in the project code cell.

Note — making changes to a downloaded project template will not write back to the Project
Templates area. Any changes made to the project template after download will be applied
only to the newly created project.

B ‘ LE | D | E | F | G | H | | | J | K
Header

E (Title

Project Project BRAND NEW PROJECT

The project can now be traced in Sage 200 by the Project Code populated by Excel Data Bridge

and the project structure created is shown in the left-hand panel.

4 { Processed
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Amend Project - O X

moject Structure Project
=-1%] 0000000024, BRAND NEW PROJE| Jll Code: 0000000024 Title:  BRAND NEW PROJECT
a2 Kitchen Sale, Kitchen Sale

= Fitting, Kitchen Fitting

== Measurements, Kitchen Meas| | petgiis [F gy e e
=z Plaster, Plastering service for P
=z Removal, Kitchen Removal Current Status
- - " g _—
»= Tiling, Tiling work on Kitchen
=2 o g Status:  Open Complete (%): 0 ‘ Change Status...
Description

Kitchen Project for Tynedale bank.

Cad design to be organised and other external factors to be considered.

...from Existing Project

Any existing project records in Sage 200 can also be downloaded into Excel Data Bridge and

new projects created from them.

There are two further buttons available to the Excel

Y Projects Filter Insert Periods e

Data Bridge ribbon to enable project records to be | & Download Projects C'e:e/
rea
downloaded from Sage 200, the Projects Filter Sl A Amend Project

Project Accounting

and Download Projects buttons.

Step 1 — Set Filter

Click the Projects Filter button from the ribbon. Setting a filter uses the same logic as filters in
Sage 200: -
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FIELD VALUE

For example, add the following filter to download the Sage 200 project record 0000000024 : -

& Download Filter = O X

And

Wildcards can also be used to download projects containing certain data. For example, if | wasn’t

sure which project | needed from the range 20 - 29, | would add the following filter: -

&3 Download Filter - O X

erieerng

iAnd; ¢ '
‘... [ProjectCode] Is like 000000002 |

The underscore wildcard replaces the final digit in the project code to allow project records from

20 to 29 to appear for selection in the download.
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Step 2 Download Data

-

Once the filter has been set, click Download Projects. A pre-filter window appears to allow the

required project(s) to be selected.

& Download X
Download Select All Deselect All Cancel
Item ID Project Code Title Project Status

127717 0000000020 Cherrie - 2... InProgress
I 127763 0000000021 Future Ho... Open
] 128117 0000000022 George Gre... Open

| 1764212 0000000023  test In Progress
8 1764321 0000000024 BRANDNE... Open

When downloading data from Sage 200, any existing data in the template will be overwritten in
the worksheet. A message appears confirming this to give the opportunity of saving the file before

the data is downloaded.

Data Import

The downloaded data will overwrite the current sheet. Continue?

Clicking Yes, will download all data from the Sage 200 projects selected for download.

See example below where project 0000000020 has been downloaded

E 1 F | G | H | | I J | K ; M
GroupBylD ﬂ
1 27717
1 4 v
X 127727 127717 Group Consult Consultation with Customer regarding new kitchen. In Progress 0
4 4 v 4
1 127736 127727 Item Site Visit On Site Visit to discuss options In Progress 0
4 r 4 r
1 127742 127727 Item Proposal Submittion of Proposal In Progress 0
1 4 | 4 4 1 4
1 127748 127727 Group Design Cad Design and Print In Progress 0

This time note the Project Code and Title have also been downloaded from Sage 200. These
will need to be amended before creating the new project in Sage 200.
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Step 3 Make changes

When creating a new project based on an existing project, remove the existing project code (to
allow a new project to be created), change the project title to reflect the new project, and make
any other changes required before attempting to create the new record.

E [ I < H | [ | S K L | M
Details

I | ProjectStatus ﬂ Complete% ﬂ
In Progress

R [itle
Consultatiof] Cherrie - 29 Chelford

GroupByID ﬂ
A

1 27717
4 ; £

v

'1 '127727 '127717 Group Consult Consultation with Customer regarding new kitchen. In Progress '0
'1 '127736 '127727 Item Site Visit On Site Visit to discuss options In Progress '0
'1 ’127742 '127727 Item Proposal Submittion of Proposal In Progress 'O
1 127748 127727 Group Design Cad Design and Print In Progress 0

Let’s say in this example, | need an extra project item added to the structure, and it needs to be

part of the group for Cad Design and Print. Enter a new row of data as follows: -

* GroupBylID = 1 (as the other rows in the project contain this number)

* lItemlD = 127749 (the next unique number in the ltem ID column)

* ParentlD = 127748 (the Item ID of Cad Design and Print where new item belongs)
* IltemType = Item (selected from the drop-down list)

* Code = 3d Imagery (selected by browsing the code cell)

. And any other required changes

E F G H | J K L M
GroupBylID B itemip ﬂ parentiD B ProjectCode H ItemType - Code - Title [~ | ProjectStatus [~ | Complete% [~ |
il 127717 Project Consultation Cherrie - 29 Chelford In Progress
v L4 v
1 127727 127717 Group Consult Consultation with Customer regarding new kitchen. In Progress 0
4 3 2
1 127736 127727 Item Site Visit On Site Visit to discuss options In Progress 0
v r v r
1 127742 127727 Item Proposal Submittion of Proposal In Progress 0
v |4 r r
12% 127727 Grq“n Iiﬁilﬁﬂ i ii Iiﬁilﬂﬂ ind Print 1n Progress 0
I 1 127749 127748 Item 3d Imagery 3d Imagery In Progress 0 I

Step4 Send to Sage 200

To create a new project record, enter C in the Create/Amend column against the project level
item then click Create / Amend Project.

The status changes to processed and a new project code is assigned.
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The project can be traced in Sage 200 by the Project Code populated by Excel Data Bridge and

the project structure (including the new project line created for 3d Imagery) is shown in the

lefthand panel.

itemiD B@ ParentiD B | Projectcode | @ itemType Bd code B2 titie
Project Consultation |Cherrie - 29 Chelford
v

'1 '127717 Group Consult Consultation with Customer regarding new kitchen.
'1 '127736 '127727 Item Site Visit On Site Visit to discuss options
'1 ’127742 '127727 Item Proposal Submittion of Proposal
B 127748 127727 Group Design Cad Design and Print
1 Mo77a9 127728 Jtem 3dImagery 3dImagery
Amend Project - m} X

Project Structure Project

BD 0000000025, Cherrie - 29 Chelford Code: 0000000025 Title:  Cherrie - 29 Chelford
(=[] Consult, Consultation with Custome

Selected Project Level: (-Zonsulhtion

——
pmm Costs & Charges | Contact Info | Attachments | Memo

0
Design, Cad Design and Print
=z 3d Imagery, 3d Imagery Current Status

Status: In Progress Change Status... l
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New Project from Scratch

To create a project from scratch involves manually populating data in each column required. See

example below where a basic project structure has been created with the minimum data required.

A B = D E IF G H | J K

2 Header

E Status -Create/AmHCreateDelen MoveLivelﬂ GmuvalDﬂItemlDﬂPalentlDﬂPmiectCodeﬂltemTvpeni:Dde -T'ltle

4 C A 1 Project Project Project

5 A ] M Group Consult Consultation with Customer regarding new kitchen.

6 A € £ Item Site Visit On Site Visit to discuss options

The data has been entered as follows: -

. Create/ Amend = C (against the first row of data only)
« GroupBylID = A (against each row in the project)
. ItemlD = 172/ 3 (unique number against each row in the project)
. ParentlD = blank / 1/ 2 (point to unique Item ID where each row should sit)
. Project Code = left blank to allow Excel Data Bridge to return a new project code
. ItemType = relevant item type for each row selected from the drop-down list
. Code= relevant code for each row by browsing on the code cell
. Title = populates automatically by browsing the code cell, but can be

amended manually for each row in the project

NOTE - if your Sage 200 project data contains mandatory Additional Information fields,

these must also be populated in Excel Data Bridge to create the project successfully.

Create / Amend Project will attempt to create the project in Sage 200. If successful, the status

cell will change to Processed and the new project code will be returned in the project code cell.

A B C D E F G H | J K
PEICAGET. N
Status ﬂ Create/Amﬂ CreateDeleﬂ MoveL‘rveﬂ GroupBleﬂ ItemID ﬂ ParentiD I | ProjectCode ﬂ ItemType ﬂ Code ﬂ Title
Processed JC A 1 Project Project Project
Processed A " 4 Group Consult Consultation with Customer regarding new kitchen.
Processed A "3 " Iitem Site Visit On Site Visit to discuss options

Again, the project can be traced in Sage 200 by the Project Code and the structure shown in the

left-hand panel.

Amend Project - O X

Project Structure Project

E\«L‘J 0000000026, Project Code: 0000000026 Title:  Project
E«" Consult, Consultation with Customer ri

LaZ Site Visit, On Site Visit to discuss

WP Costs & Charges | Contact Info Attachments | Memo
I
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Move Live Project

Excel Data Bridge can take existing live Sage 200 projects and move them into a new project, in

the same way as Move Live Project does when amending a project structure in Sage 200.

Let’s say we want to create a brand-new project and move two existing live Sage 200 projects,

projects 27 and 28, into this newly created project.

Amend Project

Project Structure

Project

E\[:l 0000000027, PROJECT 1 Code: 0000000027 Title: PROJECT 1

(-E Consutt, Consultation with Cus = .
Selected Project Level: Project

1:=C1EW Costs & Charges | Contact Info | Attachments | Memo

Current Status

Status: Open Complete (%): 0 | Change Status...

Project Structure

Project

E’“-L‘J 0000000028, PROJECT 2 Code: 0000000028 Title:  PROJECT2

[ Consult, Consultation with Cug| . B
Selected Project Level: Project

1TSS Costs & Charges | Contact info | Attachments | Memo

Current Status

Status: Open Complete (%): 0 | Change Status...

In Excel Data Bridge, we would complete the data for the new project as normal, including: -

» the letter C in the Create/Amend cell
* aunique character in Group By ID
* aunique ltem ID

+ leaving the Project Code empty to allow Excel Data Bridge to generate a new one

any other required data for the new project

B C D | E | F G H | J K L
Header Details
Create/Amﬂ CreateDeleﬂ MoveLivePﬂ GroupByID ﬂ ItemiD ﬂ ParentiD ﬂ ProjectCode ﬂ ItemType ﬂ Code ﬂ Title ﬂ ProjectStatus =
C A 1 Project Project Project Open
TRUE A n h '0000000027  Project Project PROJECT 1
TRUE A "3 1 '0000000028 | Project Project PROJECT 2

For any projects required to become part of this new project, we would complete: -

* the word TRUE in the MoveLiveProject cell

+ the same unique character entered for the new project in Group By ID
* aunique Item ID

+ the Item ID of the new project as the Parent ID

+ the Project Code and Item Type of the existing projects
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Create / Amend Project will attempt to create the project in Sage 200. If successful, the status

cell will change to Processed and the new project code will be returned in the project code cell.

Processed Project Project Project

Processed 0000000027
4

Project Project PROJECT 1

Processed 1 0000000028 Project Project PROJECT 2

Again, the project can be traced in Sage 200 by the Project Code and the new structure,

including the moved projects, shown in the left-hand panel.

Amend Project - O X

Project Structure '\ | Project

1:1~~-|:_] 0000000031, Project Code: 0000000031 Title:  Project
-

-] 0000000027, PROJECT 1 sl PRt Bk PRt
|| 0000000028, PROJECT2 it

Detﬁh Costs & Charges | Contact info | Attachments | Memo

Current Status

Status: Open Complete (%): 0 ’ Change Status... ‘

Group By ID

When creating multiple projects in Sage 200 at once, Excel Data Bridge needs to let Sage 200
know when a new project should be created. It does this by assigning certain fields as “key fields”

which can be seen by selecting the Key Fields button from the ribbon.

The only key field assigned in the Project Accounting worksheet is the KR e

field for Group By ID, so when creating multiple projects via Excel Data GroupByld

Bridge, it’s vital that data is entered in this column.

If unique data is entered in the Group By ID field against each project line belonging to a single
project, separate project records will be created in Sage 200.

See screenshot below where two new projects are being created with three rows of data for
each.
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Project 1 has the letter A against each row within it, and Project 2 the letter B.

Any unique data can be entered in the Group By ID field, so using numbers 1 and 2 instead

would have had the same effect.

[ 8 h |

AIIFieIdsl Details Cost&Charges | BudgetsByPeriod ‘ CustomerBillingDetails ‘ Contactinfo ‘ Mominal mHelp&Support
E—

In this example, leaving Group By ID empty would create a single project record in Sage

200 for the first group of project data found in the worksheet. Any subsequent projects in

the worksheet would be ignored, and therefore not created in Sage 200.

Working with existing Projects

If amendments are required on existing projects, rather than using the AllFields worksheet, we
recommend using the worksheet that most closely matches the area in the Sage 200 project

record where changes would be made.

For example, if changes to any Contacts listed against projects are required, use the Contact

B C D E F G H | J K
Header [
ItemiD ﬂ ParentiD - ProjectCode Rd ltemType Rd Code Title
M Project Project PROJECT 1
£ ¢ Group Consult Consultation with Customer regarding new kitchen.
'3 f Item Site Visit On Site Visit to discuss options
¢ Project Project PROJECT 2
£ h Group Consult Consultation with Customer regarding new kitchen.
'3 " Item Site Visit On Site Visit to discuss options

Info sheet, or if changes to Budgets are required, use the Budgets by Period sheet.

Each additional sheet contains fewer columns than the AllFields sheet making it easier to work

with.

See examples of how the additional tabs can be used to amend existing projects over the next

few pages.
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Contact Info

Let’s say you need to change the contact details on any projects with John Duffy as a contact.

John should be replaced with Rebecca Duffy instead.

Step 1 — Set Filter

From the ContactInfo sheet, click the Projects Filter button from the ribbon and apply the

following filter: -

&3 Download Filter - O X

...........

...........

Step 2 — Download Data

Once the filter has been set, click Download Projects and select the required projects from

those offered in the Download window, and click Download.

@ Download — O X
Download Select All Deselect All Cancel
v Item ID T Project Code  Title Project Status

108431 0000000008 Kitchen Ins... Complete

108583 0000000011 Kitchen Ins... Complete

108693 0000000013 Kitchen Ins... Delete

123854 0000000015 Plot66 - All... Complete

127068 0000000018 Better Kitc... Bid

127717 0000000020 Cherrie - 2... InProgress
1764212 0000000023 Cherrie - 3... InProgress
1764440 0000000025 Cherrie - 2... InProgress

v
4
v

Click Yes when prompted to overwrite the current data in the sheet.
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Step 3 Make Changes

Locate the ContactName column. In this example column U, and either manually replace any
instances of John Duffy with Rebecca Duffy, or use Excel’s Find and Replace functionality to

change the data in the column.

Find and Replace ? X

Find Replace

Findwhat: | John Duffy ™
Replace with: | Rebecca Duffy| ;‘
Options > >

Replace All Replace Find All Find Next Close

Add the letter A in the Create/Amend flag column (B) to ensure the changes are posted as

amendments to the existing projects.

ParentiD

ItemType Code Title
Project Project Kitchen Install Project for Fesi

108431 Project Consultation Initial Consultation for Festive

Step 4 — Send to Sage 200

Once the changes to the data have been made in Excel Data Bridge, click Create/Amend

Project to make the changes in Sage 200.

If the amendments are posted successfully, the Status column will return a status of ,

and the amended contact details will appear in Sage 200.

Amend Project - O X

Project Structure Project

El~~~|:_| 0000000008, Kitchen Install Projec| Code: 0000000008 Title:  Initial Consultation for Festival Homes
@#-{"] 0000000008, initial Consuttatio
@ Phase 1, Phase 1 Prep
@[ Phase 2, Phase 2 Install

[ Phase 3, Phase 3 White Good

Selected Project Level: Consultation

Details | Costs & Charges wm Attachments | Memo

‘ez Kitchen Sale, Kitchen Sale Contact Information
Design Contact Rebecca Duffy

Description | Contact | Defivery
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Budgets by Period

You also need to enter some cost budgets against a particular Sage 200 project for the year.

Step 1 — Set Filter

From the BudgetsbyPeriod sheet, click the Projects Filter button from the ribbon and apply the

following filter to download a single project: -

& Download Filter — O X

...........

...........

[ProjectCode] Equals 0000000023

Step 2 — Download Data

Once the filter has been set, click Download Projects and select the required projects from

those offered in the Download window, and click Download.

& Download = O X
Download Select All Deselect All Cancel
’ \/ Item ID Project Code Title Project Status
|
M 1764212 0000000023 Cherrie - 3... In Progress

Click Yes when prompted to overwrite the current data in the sheet.

Step 3 Make Changes

Locate the Period column in the worksheet and select the first cell in which the budgets should

be assigned, in this example cell M4.
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Cherrie - 31 Chelford True True
Consultation with
Customer regarding
new kitchen.
Including proposal
and required print
Consultation with Customer riouts.

YProjectsFiIter I Insert Periods I |

1T

L ) -
o5l Insert Period Rows - O X Create/

Amend Project

R,

Now click Insert Periods from ‘ i
Enter the number of period rows to insert and the first CLOLRTNG
period date. Lines will be inserted and subsequent period

the Excel Data Bridge ribbon, s e
this will allow the required o
number of rows to be added to HIRSL AR pbor GE olvei Riase -
: od Period Tota
o ISR =——

oK || Cancel |

(el

Enter the number of rows required, for example 12, then select the first period date required from
the drop-down list before clicking OK. The periods will be inserted into the sheet, moving the rest

of the sheet data down.

D E F G H J K L l M \

ProjectCode ItemID ParentlD ItemType Title Description OverrideCostBudget UseBudgetsByPeriod

7)000000023 '1764212 Project Consultation Cherrie - 31 Chelford True True 31/01/2022
1764212 28/02/2022
1764212 31/03/2022
1764212 30/04/2022
1764212 31/05/2022
1764212 30/06/2022
1764212 31/07/2022
1764212 31/08/2022
1764212 30/09/2022
1764212 31/10/2022
1764212 30/11/2022
1764212 31/12/2022
r r Consultation with ;J

Customer regarding

new kitchen.

Including proposal

and required print
1764222 1764212 Group Consult Consultation with Customer riouts.

Now add any cost quantities / cost values required for each period.
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M | N 0
Period TotalCostQuantity TotalCostValue
31/01/2022 n "1000
28/02/2022 < "000
31/03/2022 n "1000
30/04/2022 < "000
31/05/2022 n "1000
30/06/2022 < "000
31/07/2022 ¢! "1000
31/08/2022 < "000
30/09/2022 ¢! "1000
31/10/2022 < "000
30/11/2022 ¢! "1000
31/12/2022 < "1000

Add the letter A in the Create/Amend flag column (B) to ensure the changes are posted as

amendments to the existing projects.

Create/Amend GroupByl ProjectCode ItemID
'0000000023 1764212

P> > rrrrPr>rr

Step4 Send to Sage 200

Once the changes to the data have been made in Excel Data Bridge, click Create/Amend

Project to make the changes in Sage 200.

If the amendments are posted successfully, the Status column will return a status of

and the amended budget details will appear in Sage 200.
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| Project Structure Project
| =-{7] 0000000023, Cherrie - 31 Chelfor | Code: 0000000023 Title:  Cherrie - 21 Chelford
| (-5 Consutt, C ion with Cug
| Budgets By Period = O X
I
L
[ Period Breakdown
Period a| Total Cost Qty | Total Cost Value (I8
30/11/2021 0.00 0.00
i 200 2
1/01/2022 1.00 1000.00
28/02/2022 1.00 1000.00
i 31/03/2022 1.00 1000.00
30/04/2022 1.00 1000.00
M 31/05/2022 1.00 1000.00
i 30/06/2022 1.00 1000.00 _
31/07/2022 1.00 1000.00
31/08/2022 1.00 1000.00
30/09/2022 1.00 1000.00
31/10/2022 1.00 1000.00
30/11/2022 1.00 1000.00
= @12/2022 1.00 1000.00
I Total 12.00 12000.00
| z = otals l
i =

Tips — Filters

+ Clicking the + next to And allows you to add a condition, or use the Insert or Add keys.
+ Clicking the x at the right of a condition allows you to delete it or use the Delete key.
+ Clicking And allows you to: -

& Download Filter
o Add a condition
= g"" " O  Add a group of conditions
@ Or
@ Not And
| @ Not Or o Change the linking operator on a filter with multiple
=, Add Condition conditions
=* Add Group
# Clear All (o) Clear all current conditions (only if any are set)
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+ Clicking the [Field] gives access to available Sage 200 fields

@ Download Filter

O

X

And ©

‘.| ProjectCode

ContactPostcode -
ContactTelephone

CostQuantity

CostUnit

CostValue

Description

ExpenseAccount

ExpenseDept

ItemType

OtherCostsRules
OverrideCostBudgets ‘ ‘
OverrideRevenueBudgets

¥ Equals 0000000023 £

— PercentageComplete
[Proje Period
| ProjectCode

* Clicking the Operator gives access to string / numeric operators

@ Download Filter

O

X

And ©
. [ProjectCode]

Copyright of Draycir Ltd

Equals

Does not equal

Is greater than

Is greater than or equal to
Is less than

Is less than or equal to
¢ Is like

%¢ Is not like

@ s any of

@@ s none of

O Isnul

@ Isnotnull

NANVV Y

o oo
2

= Equals v 0000000023 &
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+ Standard wildcards can be used when entering string values

S x 3L

+ Use the correct linking operator on filters with multiple conditions. To download multiple

numbered project codes, use Or not And. If the filter is invalid, nothing will download.

€3 Download Filter = m}

X €3 Download Filter = O X

Oor ©
\ [P ectCode] Equals 0000000021 3
- [ProjectCode] Equals 0000000022 3
‘... [ProjectCode] Equals 0000000023

And ©
) J-Code] Equals 0000000021

- [ProjectCode] Equals 0000000022 £
... [ProjectCode] Equals 0000000023

[ProjectCode] = ‘0000000021 Or [ProjectCode] = 0000000022 Or [ProjectCode] = [ProjectCode] = 0000000021" And [ProjectCode] = 0000000022 And
0000000023 0000000023

[ProjectCode] =

Tips — Downloading

If downloading project data into Excel Data Bridge is taking some time, and you only need data

downloaded from certain areas of the project from Sage 200, the download can be turned off for

unrequired sections.

@ Map Fields

AdditionalValues

BillingAmendEventID

| AdditionalValues

BillingAmendEvent D

Open the Designer and change the Download property in

BillingCompleted

BillingCompleted

' : BillingDescription BillingDescription
the section to stop data downloading from True to False. BillingEventFiag BillngEvertHag
BillingEvent|D BillingEvent ID
BillingEventType BillingEvent Type

BillingEventVal

BillingEventValue

- cIplalc

DownloadEvents

&3 Map Fields
BE2 | =

The following sections in the Designer can have the ability

to download data from Sage 200 turned off.

Copyright of Draycir Ltd Version 1.0

Page: 35



Excel Data Bridge
Project Accounting Function

Amending Templates

Deleting unwanted columns

Deleting unwanted columns within a template is a two-step process: -

1. Remove the field mappings from the Designer

2. Delete the columns in the Excel template

Open the Designer to view the current field mappings. If for example, you do not use the

Budgets by Period area in Sage 200, these fields can be unmapped, and the columns deleted.

@ Map Fields

= ]
HE
BBPCostQua BBPCostQuantity
BBPRevenueQuantity BBPR: Quantity

BBPRevenueValue

BBPR

DownloadBudgetsByPeriod | True
Period Period
UseBudgetsByPeriod UseBudgetsByPeriod
ContactAddress1 ContactAddress1
ContactAddress2 ContactAddress2
ContactAddress3 ContactAddress3
ContactAddress4 ContactAddress4
ContactAmend|D ContactAmendID
ContactDescription ContactDescription
ContactEmail Contact Email
ContactFax ContactFax
ContactFlag ContactHag
ContactName ContactName
ContactPostal ContactPostal
ContactPostcode ContactPostcode
ContactTelephone Contact Teleph
Download True
SetAsDelivery SetAsDelivery
BBPCostQuantity

allows setting of cost

Specify the cost quantity. This will depend on whether the item type

1. Clear the mapping against the first field no longer

required

&3 Map Fields - O X
s=2l | =

BEPCostQuaniity I

BBPRevenueQuantity BBPRevenueQuantity

BBPRevenueValue

BBPRevenueValue

2. Repeat for any other unrequired fields

3. Close the Designer

4. Click Validate Design to check for errors

Right click the column heading to remove and select Delete > Table Columns. Repeat for any

other columns required.
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BudgetPeriodCostQuanti 3—(‘ .

 Paste Options:
ke

0

Paste Special...
}D Smart Lookup

Insert »
% Table Columns Delete >
Select »

Adding Rows and Columns

The worksheet templates have been created in an Excel table with the correct formatting
applied.

To add additional rows, firstly locate the cell at the bottom

right-hand corner of the formatted table.

Now select the cell, then click and drag down on the arrow. Extra rows will be added with the

correct formatting.

RevenueDept [~ | RevenueNominalDescription [~ |

' R g il Saadlaieana it S B udgetPeriodRevenueVal Bc
If a column has been deleted in error and E% o
i@ Copy

you’d like to bring it back again, right click % Paste Options:
on the column heading where you would like O

Paste Special...
your new column to appear and select - ¢ O smart Lookup

Insert > Table Columns to the Left
Insert » H‘m Table Columns to the Left
Delete >
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A new column will be added, named Column1. Rename the column in Excel, then refer to the

next section on how to map this column in the Designer.

AU AV

M | udgetPeriodCostvalue B

. J

Mapping a new column

Once a new column has been added to the template, it can be mapped to the required Sage 200
field.

' BudgetPeriodCostQuantity h BudgetPeriodCostValue ﬂ

BBPCostQuantity column re-added to the template

to allow the cost quantity to be entered against the

project item.
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Click Designer to open the mappings for the template and locate the field to map the column to.

@ Map Fields

BBPRevenueQuantity :1'32:2'23521' ,
BBPRevenueValue BBPRevenueValue :
DownloadBudgetsByPeric| True

Period Period

UseBudgetsByPeriod UseBudgetsByPeriod

ContactAddress1
ContactAddress2
ContactAddress3
ContactAddress4
ContactAmend|D
ContactDescription
ContactEmail
ContactFax
ContactFlag
ContactName
ContactPostal
ContactPostcode

ContactTelephone

Download True

SethsDelivery SetAsDelivery v

BBPCostQuantity
Specify the cost quantity. This will depend on whether the item
type allows setting of cost budgets

select the cell range for the 1 AU | AV 1 AV
BBPCostQuantity column before

clicking OK. BBPCostQuantity ? X

Select cell(s) ()
[ |
The column is now mapped and can be - [Tox ]| concer |

populated in Excel Data Bridge.
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